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Chapter 1

Introduction

Welcome

Welcome to aceconnect School Management. This User Guide will explain concepts and application
operations to help use the software in your school.

Should you experience difficulty during the installation or with program operation, you may contact
A.C.E. Technical Support at 615-612-5288 or email technicalsupport@aceschooloftomorrow.com.

Common Features and Elements

Throughout the application, certain common features and elements are used. Understanding these
features and elements will help you use the software more effectively.

The main School Management window is laid out in three columns with the left column for navigation,
the large center section for working with the selected data, and a right column with helpful shortcuts
to this User Guide or reports associated with the current section in view.

Menu Bar
The menu bar is a container for various action buttons used throughout School Management. Some
common action bar types are:

» Clickable Action Buttons — New, Edit, Delete, Print, etc.

» Dropdown Selection — Allows selection from a list (typing can narrow the selections) or, in the
case of date entries selection, a calendar

+ Filter Button — Sets a filter for a data grid display

+ Refresh Button — Reloads the display with current data from the SMS Server database

lq]: New o7 Edit $% Delete | Acad.Year | 2021-2022 8 v &
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Data Grid
Grid elements are used to display data on many screens. Select an item in the grid by clicking on the
row.

Altering data grid display:

+ Sorting
Any data grid can be sorted alphanumerically by clicking on the name of any column (or
reversed by clicking again).

* Filtering
Many data grid screens will have a Filter button - in the menu bar with common options for
that screen.

Any data grid can be filtered by column values by clicking on the small Filter button that
appears in the upper right corner of the column header when your pointer is over it. Options
appropriate for the column’s data will show (such as > or = for numbers or a clickable calendar
for dates).

When a display is limited by a filter, a notation at the bottom of the window will note the filter in

use. Example: The Browse Students screen in the Students section defaults to show only students
enrolled in the selected year. The blue bar at the bottom shows that only the students whose status is
Enrolled are displayed, just as the filter option is set.

2t Highland School
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Chapter 2

Installation Section

School Management consists of two main components or “packages” — the “SMS Server” component
(Microsoft SQL Server database storage with a Windows® service) and the “SMS Client” component
(user interface). These components can be installed in a network configuration (a server computer
and one or more client computers) or in a single computer configuration (both the server and the
client components on a single computer).

Hardware Requirements

Client Server Server

(minimum) (minimum)  (recommended)
Processor 800 MHz or ZGn:I:Itc:cf:rs(:er
faster 1GHz or faster
processor
Memory 512MB 4GB 6GB+
Hard Any 100GB 250GB+
Drive

Software Requirements

Below are the software requirements for both the server and client computers if installed separately. If
installed on a single computer, the server requirements are applicable.

School Management is Windows software and can be installed only on supported Windows
environments.

Server

Microsoft® Windows® 10, Microsoft® Windows® 11, or Microsoft®
Windows Server® 2016 (or any higher version)

Microsoft® Windows® 8, Microsoft® Windows® 10, or Microsoft®
Windows® 11
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Installation Prerequisites

If you have Internet access and Windows updates are current, the prerequisites will be installed when
running the School Management installation on that PC.

If the PC onto which you are installing School Management does not have Internet access, you
will need to download the installer files using a device with Internet access and copy them to that
computer (using a USB drive with approximately 1GB of free space).

To get the installer for Microsoft SQL Server 2019 Express

(only needed for the SMS Server installation without Internet)

* Use the link below to get the SQL Server 2019 Express installer (SQLServer2019-SSEI-Expr)
on the device with Internet access to download the installation media:
https://www.microsoft.com/en-us/download/details.aspx?id=101064

* When you open and approve this to run, select Download Media.

* On the next screen, with the Express Core option selected, click the Browse option to select
the USB drive as the location to download the SQLEXPR_x64_ENU.exe installer file.
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Installation Steps

For PCs with Internet access, the School Management installer will download and configure both the
Microsoft SQL Server prerequisite and the School Management software.

For those without Internet access, first use the SQLEXPR_x64 ENU.exe installer file downloaded
with the instructions above before using the School Management installer on your main PC.

During the installation of the “New stand-alone installation” of SQL Server, you can accept all default
settings except on the Instance Configuration screen, where you will choose a named instance and
type the name SMS2.

T S Serwer 2019 Setup - o

Instance Configuration

Sperily the nome and imstanc e 83 for he instente of S0 Serven brtane e 1 besomes past of bhe installatian path

Ginbal Kules () Dl snctanc e

Microsoft Lipdate 0 Mened instance | IR |
Inghall Sebup Files =

Instzil Rutes

Installaten Trpe It I a2 |
Lsrense Teirms

Feature Selection

Fratane Hides SOL Server diteionys CWProgram Files'\Miciosolt SOL Server\M350L1 5.5M52

Instance Conflguration

To get the installer for School Management

For new School Management licenses:

» Click the Registration Link provided in the registration email and set up your Portal User
Name and Portal Password.

» After Portal User Name and Portal Password for your school have been registered, click the
Download Installer link.

For existing School Management licenses:

» Access the School Management Portal website at studentmanage.com.

* Log on with the Portal User Name and Portal Password for your school.

» Click the gold button for LICENSES.

* Use the link to “Download Installer” for the Latest Version installer.

» |If downloading for a new installation on a PC without Internet access, see Chapter 3 “Activating
the License without Internet Access” and “Updating the Catalog without Internet Access” for the
files needed before leaving the Portal website.
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When you open the schoolmanagement.exe installer, tell Windows to allow the installer (irsetup.exe)
to make changes and begin the installation.

Server Installation

To perform the server installation, choose both SMS Client and SMS Server from Select Packages
during installation. The server component (including database and Windows service) will be installed
and started. Icons for the user interface and this guide will be added to the Start menu.

NOTE: The SMS Server operates as a Windows service unseen in the background, allowing
connections to the database. The SMS Client is needed to adjust settings (even if not used regularly
on the PC). The SMS Client should be included on all installations, but it does not need to be open on
the Server to allow an SMS Client from any computer on the school’s local, private network to access
the database.

Client Installation

To perform the client installation, download the School Management installer onto each designated
computer. From Select Packages during installation, choose SMS Client and continue. Icons for the
client tool and this guide will be added to the Start menu.

Server and Client Installation on a Single Computer

The server and client components can be installed on a single computer. From Select Packages
during installation, choose SMS Client and SMS Server. Icons for the client tool and this guide will be
added to the Start menu.
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Chapter 3
Login/Getting Started Section

Login
To begin, click the School Management icon in the Start menu.

The client component requires a connection to the server component. The application automatically
searches for the server. If not found on the same PC, the school’s local, private Windows network
will be scanned for the PC with the SMS Server database. The name of the computer where the
database is found displays as the Server. Enter the default user name admin and the default
password admin.

NOTE: It is highly recommended that you change the default password for the admin user in Setup
using the Staff and Users screen.

server Computer Name ¥
User Name | |
Password | |

.li-\.r - T

server Computer Name F

User Name | admin |

Password | o |

Login I

Once initialization is complete, the main School Management window is displayed on the Dashboard
screen.
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Getting Started

To associate your server installation with the Portal account and your A.C.E. account, follow these
steps to download the license and update the catalog.

Download the License

At installation, the program will open in Demo Mode with the school name as Demo School and will
only allow working with one student. When the license is downloaded and activated, the software will
show the school name as registered and permit access to all features of the program. The steps to
activating the license are as follows:

NOTE: If you have

and click Submit. A

password will be sent.

forgotten your Portal user
name or password, go to
studentmanage.com and
click Forgot Password.
Enter the email address
for your school’s license

message with your user
name and a temporary

Activating the License with Internet Access
1. Open the Home menu and click License.

. Enter your school’s Portal User Name.

. Click Change... to enter your school’s Portal Password.

. The word "Success" should appear in the Portal Account Status box.
. Click Download License.

o O AW N

. Log out of School Management and log back in. The school name
as registered will now appear in the program, which has opened to
full access.

(To change the school name as it appears in the software, contact
A.C.E. Technical Support by phone at 615-612-5288 or by email at
technicalsupport@aceschooloftomorrow.com.)

S P
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Activating the License without Internet Access

. On a computer with Internet access, log in to the Portal at studentmanage.com.
. Click the Licenses tab.

1
2
3. In the License column, click the Download link.
4

. Save the file to an external hard drive, flash drive, or other portable device to transport it to the
School Management server computer.

5. On the computer with the School Management server, copy the license file to the program
folder: C:\Program Files (x86)\School Management System\

6. Restart the computer.

7. At next login to School Management, the school name as registered will appear in the
program, which opens to full access.

Software Updates

With Internet access, when a newer (higher numbered) version of the software is released, an
Update Available notification will display in the top right of the School Management window where
the version number usually displays. For schools without Internet access on the server computer,
please log in periodically at studentmanage.com and check the Licenses section to see if the Latest
Version is a higher number than what is currently in use at your school. Software updates are made
by downloading the installer for the higher version number and running it over the older installed
version.
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Update the Catalog

When School Management is first installed, it will include a basic (but outdated) A.C.E. curriculum
catalog. It is important to run a catalog update after the installation is complete. The catalog must be
updated from this default catalog for ordering to be possible through School Management. Shipping
addresses for your account are included in this download.

Updating the Catalog with Internet Access

1. Open the Home menu and click Portal Settings.

2. With the Portal Account Status reading “Success,” click Update Now in the Catalog and
Orders section.

3. The Catalog Last Updated at field will display the date and time of the update.
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Updating the Catalog without Internet Access

A WODN -

. Click the Updates tab.
. Click Download Latest Catalog File.

to the School Management computer.

5. On the computer with School Management, log in to the program.

(o))

. On a computer with Internet access, log in to the Portal at studentmanage.com.

. Open the Inventory menu and click Catalog.

. Save the file to an external hard drive, flash drive, or some other portable device to transport it

7. Click Manual Update and select the catalog update file that you downloaded from the Internet.
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Chapter 4

Setup Section

To set up School Management, click Setup in the left panel.
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School Configuration

The School Configuration page contains basic school information. As the top page in the section, the
School Configuration page will appear first when you select the Setup section with the buttons in the
lower left.

Academic

* Auto Issue PACE — Automatically issues the next PACE in that subject (if in stock) when a
passing score is entered for the student

» High School Avg — Controls whether the overall high school average is calculated using only
PACE subjects, only Non-PACE subjects, or both (default)

» High School Avg Use GPA Weight — Controls whether the overall high school average is
calculated using the GPA weight settings for each subject (off by default)

* Minimum Score — The default minimum passing score for any PACE or academic item as
established when setting up subjects
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Billing

» Bill PACEs — Determines if or when PACE charges are applied to the family for those used by
each student

When Bill PACEs is set to something other than Never, use the settings below for how the
PACE fee is calculated.

* PACE Fee (Per PACE) — The amount billed for each PACE issued to a student

* Plus Repeat PACE fee — The additional amount billed for each repeat PACE issued to a
student

* Plus Percentage of PACE Cost — Option to use actual cost of the PACE item (Inventory >
Catalog) as a percentage when calculating the charge for each PACE used

To show how these settings work as a Bill Run posts PACE Fee charges for a student to his family,
take, for example, a PACE that costs the school $2.48 per copy. This is how the charge would be
calculated:

o 1f150% is entered in the Plus Percentage of PACE Cost field and the PACE Fee (Per
PACE) is set at $0.00, the amount to be billed is calculated as:
$2.48 x 150% = $2.48 x 1.5 = $3.72.

o Ifthe PACE Fee (Per PACE) is set at $3.00 and the Plus Percentage of PACE Cost is set at
50%, the amount to be billed is calculated as:
$3.00 + ($2.48 x 50%) = $3.00 + $1.24 = $4.24.

o If the student must repeat this PACE and Plus Repeat PACE fee is set at with the
PACE Fee (Per PACE) set at $3.00 and the Plus Percentage of PACE Cost is set at 50%,
the program will calculate the charge for the repeated PACE as:
$3.00 + +($2.48 x 50%) = $3.00 + + $1.24 = $6.24.
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Contact (School contact information)

+ Fax

* Mailing Address (where the school receives mail)
* Mailing Address 2

+ Mailing City

» Mailing Country

* Mailing ZIP/Postal Code

* Mailing State/Province

* Phone

Schools in California,
Indiana, or other areas
awarding high school
credit other than 1 credit
for a full-year course,
please pay special
attention to “High School
Subjects” on page 27.

(Box at bottom for “Physical Address and Mailing Address are the Same” can be selected so data

does not need to be retyped.)
* Physical Address

* Physical Address 2

» Physical City

* Physical Country

» Physical ZIP/Postal Code
* Physical State/Province

Inventory

* Allow Online Ordering — Determines whether the system will automatically order PACEs
* Order PACEs Ahead — Indicates the number of PACEs per subject to order ahead for each

student when Allow Online Ordering is checked

» Use Free Floating Mode — Determines how ordered and inventory PACE items relate to

students

o When using Free Floating Mode (checked), the program uses smart logic to determine
when to order PACEs but does not assign them to a specific student. PACEs added to
inventory manually will be assigned by the program to a student as the need for the PACE

arises.

o When not using Free Floating Mode (unchecked), PACE inventory is tracked by specific
Assigned Student. PACEs ordered by the Automatic Order are in Inventory as Ordered
and Assigned to the student that caused the item to be ordered. PACEs added to inventory
manually without an Assigned Student will never show as In Stock for a student to be used
and will remain in inventory unused with Automatic Order continuing to order new assigned

PACEs for the students.
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School The program will scale your

school logo to the correct

* Administrator Name size. However, to maintain

* Logo the correct proportions, it
To add Logo image, click in the area to the right of the label that is recommended that your
defaults to the text “No image data,” then right-click in the same school logo have the same

horizontal and vertical

area to access the image options menu to Paste if copied or Load measurements (a square).

to select an image file. Your logo will display in the upper left next to
the school name in the software and on any printable report.

Academic Year

The Academic Year page contains date settings for all years with data in the program. Open the
Setup section from the buttons in the lower left and click Academic Year in the links above.

To create and configure an academic year, click New. Type a Name for the year (e.g., “2022-2023”),
enter the Begin Date and End Date values, and click Save at the top.
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After saving, use the Details area to configure the grading periods for the academic year.

» Period Type — This is based on the number of grading periods during the year. Options are
Quarter (4), Trimester (3), and Semester (2). After choosing the Period Type, each period
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defaults with a Name and approximates for Start Date and End Date. Edit the details of the first
period and click Update. Then use the slider to advance to the next period to edit and update
its details. Continue this process until all periods are configured.

» School Days — Valid school days are highlighted by period on the School Days calendar. Click
any day in the calendar to toggle (highlight) the school day on or off.

NOTE: The School Days calendar provides the record for the number of school days in session that
appears on student record reports. It is important that any days school is not in session (such as
days off surrounding Christmas) be toggled off and all days in session be toggled on for accurate
attendance reporting.
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Suggestion: When editing the School Days calendar, maximize the School Management window to
use the full screen and see more months (perhaps full year as above) on the calendar.

+ Click Set as Current on the top menu. A green check mark will appear on the row for that
academic year.

Additional actions include:

+ Save — Save the academic year that is currently being edited.
* New — Add a new academic year.
» Delete — Click the year you wish to delete and click Delete.

+ Set as Current — Click the year you wish to set as the current academic year, and click Set as
Current.

If another year was current and a newly created year with no information is selected when Set as
Current is clicked, a prompt will allow you to choose which students from the previously current
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year to reenroll. For each returning student, complete the line by checking the Reenroll column and
selecting the Level and Supervisor for the year beginning; then click Save. (Students can be enrolled
individually later.)

After saving the students for reenroliment, an option will be given to “Move Incomplete Subject Items
to the New Academic Year.” Selecting this as recommended (though a “Do Not Move Any Items”
option is also given) will move all prescribed PACEs/Units without scores from the students’ Progress
Control screens for the year that had been current to the Progress Control screens of the new year so
they can be completed.

Roles and Permissions

School Management includes the following default roles.
* Administrators
» Supervisors
* Monitors

» Secretary

To add a new role, click New. The Roles and Permissions dialog box will appear.
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Enter a name for the new role and select the desired permissions. Click Save.

To modify the permissions for any role, select the role and click Edit.

Rooms

To add a new room, click New and enter the Name. To allow PACEs, resource books, etc. to be
assigned to that room, set the Can Have Inventory and Is Learning Center values. Navigating to
another row automatically saves the new room.

To edit a room, select it and modify the desired values.

To delete a room, select it and click Delete.

Staff and Users

The program installs with one staff account named admin. If only one person will be accessing
the program, one account may be sufficient. However, a second user in the role of Administrator is
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recommended. If one has login trouble, the other can log in to help make corrections. Additional users
would be set up on this screen:
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NOTE: Rooms must be added before adding Staff and Users. Staff cannot be assigned to a Learning
Center until it is added in the Rooms section.

To set up a new staff person or user, click New. The Select Person dialog box will display. You may
search for an existing person. If found (perhaps a past student or parent), click to select the line; then
click OK. If the person becoming staff is not already in the system, click Add New Person at the
bottom.

Select Person fx
Search For: | | I Search

' FrstName  MddeName  LlastName  NemeSuffix | CellPhone |
| admin

e Alltruth 555-710-2255

[ Paul B. Friendson 555-712-45387

= Ann 1 Content 555-710-4532

B Robert | Lovejoy

= Rachel . Lovejoy

= Christi Lovejoy

| John McMercy

B Sarah McMercy

B Bill McMercy

B Sandy McMercy

| Becky McMercy

= Charles . Upright

= Alice | Upright

= Reqinald Upright E

Add Mew Person... l Ok ] l Cancel ]
L
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If adding a new person, a dialog box will appear. Enter data in each of the fields and click Save. (Only
the fields with bold labels are required.)

Add Person 3
pefic | [
First Name | | Gender| g
[None] Middle Name | | Birthday | @
Last Name | | citizenship | |
ContactInfo | Addresses|
Cell Phone | |  Email Address | | send
Home Phone | | | Go
Work Phone | | | Go
Other Phone | | | Go

| save || conce |

Whether a person was selected or a new person was added, the Edit Staff dialog box will appear with

the Person and suggested

User Name filled in.

|§\ﬁrmeson, Ace EE

Person
User Name
Password
Verify

Staff Roles

Room

|M"|rt|.|eson

M Administrators
D Superwvisors
|:| Monitors

|:| Secretary

| /Al

]

| @ Last Password Change |

Invalid Login Count |

Last Login |

User Is Locked Out [_]

User Must Change Password [

L Save I [ Cancel
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In the Edit Staff dialog box, enter the information for this user (bold fields required) before clicking

Save:

User Name — Enter a user name for logging in. (If a red X shows, that user name cannot be
used.)

Password — Enter the desired password in both the Password and Verify fields.

o Passwords are case sensitive.

o Be sure to reset the admin password.

Staff Roles — Select the desired role(s) for the user.

Room — Select the room to which the staff person is assigned (optional).

User Is Locked Out — If this box is checked (usually due to numerous failed log-in attempts),
the user will not be allowed to access School Management until unlocked by an Administrator.
NOTE: If the admin account experiences lockout, have another user in the Administrator role
edit to unlock or, if none can log in, contact Technical Support for assistance.

User Must Change Password — Select this box to force the user to enter a new password the
first time he logs in.

To edit a staff person or user, select the name and click Edit.
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Subject Types

The Subject Types associated with subjects and PACE items in the A.C.E. catalog appear on this list
as default (blue shaded) subject types. These cannot be edited or deleted.
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To add a new subject type, click New. Enter the desired name and a color (optional).

Subjects

If your school has custom subjects that are not part of the A.C.E. curriculum catalog, add them to the
School Management Subjects list on this page. (PACE subjects from A.C.E. appear shaded blue on
this list. They cannot be deleted and are limited on what can be edited.)

To add a new subject, click New. The Subject dialog box will appear.

MName || |
Subject Type | @

| 12 ! PACEsUnits per credit(s)
GPA Weight % Starting PACE/Urit

Is PACE Ending PACE/Unit
Is Assignable Min. Passing Score

| Save H Cancel J
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Edit the information for the subject before clicking Save:

+ Name — Enter the name of the subject.

» Subject Type — Select the desired subject type from the dropdown list.

* PACEs/Units per credit — Select the number of PACEs/Units (scores) per credit.

+ GPA Weight — Select the weight (percentage) to be used for the subject when calculating
the GPA. Depending on the High School Avg Use GPA Weight option in Setup > School
Configuration (see page 16), these GPA weights may also be used to calculate the Overall
High School Average.

* Is PACE - Check the box if the subject has PACE-like units. (This links the unit score boxes in
Students > Progress Control to Inventory and Billing like PACEs.)

+ Starting PACE/Unit — Set the starting number for units.

* Ending PACE/Unit — Set the ending number for units.

* Min. Passing Score — Select the minimum passing score for this subject. This will override the
minimum score entered in the Academic section of School Configuration.

Click Edit or Delete at the top to edit or delete the selected subject. (A.C.E. subjects cannot be
deleted and are limited on what can be edited.)

High School Subjects

When adding a subject that can result in high school credits for multiple years, add separate subjects
with a unique name for each year (e.g., Physical Education |, Physical Education I, etc.).

Some areas use a different value system for high school credits other than one credit for a full-year
course. These schools must edit all subjects so the values indicate the correct number of credits
before adding or importing any student records.

Example — California, 10 credits per year:

H

MName | ] I |

Subject Type |

— v
12 ﬁ PACEsUnits per 10.0 ﬁ credit(s)

GPA Weight | 100 | :I‘}' Starting PACEUnit
Is PACE |« Ending PACE Unit _}

able [« Min. Passing Score 80 2

Q

*A CE Ttem* oo H Cancel I
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NOTE: You must set Grade Conversions

up the Academic Year

prior to modifying Grade | The Grade Conversions menu item shows the grading scale used by School

Conversions. Management. The program defaults to a 4-point grading scale. If your school
uses a different scale, set it here.

Grade Conversions settings determine the corresponding letter grade and grade points for the
numeric scores. Settings are linked to each academic year, and for your first year, the default scale
will be applied. The settings from the previous year are used when each new academic year is added.
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To edit an existing grade conversion, click on the item and modify the desired values.

* Letter Grade

* Min Score — The minimum score for the letter grade

* Max Score — The maximum score for the letter grade

» Grade Points — The grade points for the letter grade (used when calculating student GPAs)

NOTE: If editing Grade Conversions, please make sure entries exist for all possible percentage
scores (0.00 through 100.00).

Courses of Study/Graduation Requirements
School Management is preconfigured with the graduation requirements for four courses of study:

* Honors

+ College Preparatory
* General

* Vocational
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Only PACE subjects published by A.C.E. are included at installation, so it is recommended that you
make adjustments to the default courses of study to reflect your school’s requirements with any
added non-PACE subjects.

A custom course of study can be added by clicking New. Enter a Name and number of Total Required
Credits. The Base Credits will be automatically calculated as subject requirements are added to the
subjects list.

To delete a course of study, select the line and click Delete.

To add subjects for a course of study, select the line in the Course of Study grid and click New in the
Subjects grid. Enter the number of credits, select the subject type, and select the subject. Any subject
your school requires for all students in a particular course of study should be added to that course
of study. For example, if your school requires Chemistry for all students on the College Preparatory
Course of Study, add that course to the College Preparatory Course of Study. (By default, the
College Preparatory Course of Study allows a student to choose Chemistry or Physics for the third
Science credit. These would not be on this list, but such “electives” would be added individually in the
Students section.)

To delete a subject from a course of study, select the item and click Delete.

Grade Types
Grade Types are used to define student levels in School Management.

To add a new grade type, click New and enter the following information:
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* Name — The name of the grade level

+ Short Name — The number of the grade level

» Order — The sequence options appear when selecting Level for a student throughout the
program.

» Allow Kindergarten — Checking this box makes kindergarten items available for this grade type.

» Allow ABCs — Checking this box makes ABCs items available for this grade type.

To delete a grade type, select the item and click Delete.

Grade types can be deleted using the Delete option so long as no students have been assigned to
them.

Standardized Testing

Standardized Testing setup allows you to enter any number of standardized tests and score areas for
storing in students’ records.

Click New for the Add New Standardized Test dialog box. Enter the Name and Provider. In the Score
Areas, click New to Enter Name with minimum and maximum numeric scores for each Score Area
being added. Click Save when settings are complete.

A standardized test can be edited by clicking Edit or (if no student records have been added) deleted
by clicking Delete.

Desirable Traits

Desirable Traits are preconfigured in School Management. It is recommended that you do not modify
or delete them.

Desirable Traits are grouped by category. To collapse a category, click the “-” symbol. To expand a
category, click the “+” symbol. You can also collapse or expand all categories using the appropriate
buttons on the toolbar.

Though not recommended, a desirable trait can be added to an existing category using New to add a
line to enter the Name, Category, and Sequence. An added trait will go to the proper sequence order
when you click Refresh & . An existing trait can be edited by modifying that line. Clicking on another
line automatically saves changes to the trait.
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To delete a desirable trait, select the item and click Delete.

Relationship Types

Family members of students are recorded according to their relationship to the students. Many
options for Relationship Types are included in this list at installation.
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To edit a relationship type, select the item and modify the name.

If a relationship type has not been used, you can click Delete to remove it.

To add a new relationship type, click New and enter the Name. Clicking on another row automatically
saves the new relationship type.
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Note Types

School Management allows you to add notes to certain areas of the program. The type of note
determines its behavior in the area in which it is used.
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To add a new note type, click New. The Note Type dialog box will appear.

MName | |

Allove Merits
Allow Demerits [w]

Mote Subtypes:

| I{,':I New 3% Delete

| | Name | Default Demerits | Default Merits

==

Enter the desired Name and options to Allow Merits or Allow Demerits. Next, add Note Subtypes (at
least one needed for note to work) by clicking New. Enter the Name and, if desired, Default Merits or
Default Demerits. Click Save when finished.

To edit a note type, select the item and click Edit.

To delete a note type, select the item and click Delete.
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Billing Plan

Though not in the Setup section of the software, before adding families to School Management or
importing families from School of Tomorrow Management System, you must first set up at least one
billing plan.

Open the Billing menu and click Billing Plans. For additional information, see page 75.

Note: If not previously done, restart the program (log out and back in) after the license is activated in
order for the Billing Plans option to display.
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Chapter 5
STMS Data Import Section

STMS Data Import will import your existing records from the School of Tomorrow Management
System into aceconnect School Management. The import will copy existing records for any families
you select, all the students in that family, and all the students’ subjects and grades. The import will
not include attendance records, discipline records, Scripture memory, Readmaster Plus® records,
standardized tests, photographs, financial records, or inventory.

Preparation

Before importing records from the School of Tomorrow Management System, you must first complete
the steps listed in the Setup section beginning on page 16. The STMS Data Import cannot be run until
you first set up your current school year and at least one billing plan. In case you miss any of these
preparatory steps, the STMS Data Import will alert you before allowing any records to be imported.

Since STMS only displays a completion date for completed subjects, School Management imports
PACEs based on the beginning and ending dates (month and day) the user inputs when the initial
school year is set up. These beginning and ending dates (month and day) become the default
beginning and ending dates for all prior-year subjects imported into School Management.

It is possible that credits for some subjects (those completed outside the range of dates entered
above) may be assigned to an incorrect school year. To minimize the number of times this happens,
the user has two options.

1. (Recommended) Set up the initial school year with a beginning date of August 1 and your
school’s actual ending date.
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Once the import process is complete, go back into the Setup menu and change Begin Date to
your school’s actual beginning date.

2. In the Setup menu in School Management, set up previous school years with the actual
beginning and ending dates of each school year prior to the current one (as far back as you
want to be certain all credits import in the correct school year).

Selecting a Backup from School of Tomorrow Management System

The STMS Data Import requires a backup of your current School of Tomorrow Management System
records. If you don’t already have a current backup, you must make one.

1. Open School of Tomorrow Management System.
2. Click File > Utilities > Backup Data.
3. Select a location to place your backup.

a. If the aceconnect School Management server is running on the same computer as your
School of Tomorrow Management System, you can save the backup in the C:\\STMS\ folder.

b. If the aceconnect School Management server is running on a separate computer, save the
backup to a portable external hard drive or flash drive so you can transport the backup file
to the computer with the School Management server.

Running the Data Import

The steps to open and run the STMS Data Import are as follows and must be completed on the
aceconnect School Management server computer. The STMS Data Import cannot be run from a client
computer.

Start the Import

On the Windows Start Menu, select All Programs, then select School Management System. Select
STMS Data Import.

For Windows 8, select Start, then open STMS Data Import.
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Step 1 — Select Data

1. Click Select and find your backup file from School of Tomorrow

Management System.

2. Select the server for School Management. The server should be
located automatically; however, you can type in the location.

Step 2 - Select Families and Students to Import

» All family accounts included in your backup from School of

NOTE: Only records

from School of Tomorrow
Management System version
3.1.1 can be imported

into aceconnect School
Management. If your STMS
version is not 3.1.1, contact
Technical Support for
assistance. The import utility
will not import from older
versions.

Tomorrow Management System will display in a list. Select the families you wish to import into
School Management. It is recommended that you import all the families with currently enrolled
students. If you wish, you can import a single family to see how the process works and run
STMS Data Import again to import the remaining families.

* The students in the currently selected family will display on the right. Although only students for
one family will display, all students for each family you select will be imported.

* The option to Import PACEs as Billed displays on the bottom right. Choose Yes or No, or click

What’s this? for more information.

School Management - Data Import

Cancel [B]

[ Check Al Family Accounts
Import  Num First Name Last Mame =
106 Mr.& Mrs. D. Virtuason |

| Mr.& Mrs. C. Upright r
o |109 Mr.& Mrs. J. McMercy =
= |10 Mr.& Mrs. R. Lovejoy
E |11 Mr.& Mrs. H. Hurmblen
= (115 Mrs. B. Meekway
| Mr& Mrs. L Laoyalton
/= |17 Mr.& Mrs. J. Obsarvant
| RAE:] Mr& Mrs. K. Seamara
= |1z20 Mr.& Mrs. E. Wentforth -

Select the families on the left to import into
School Management. When you select a
family, all students from that family will be
imported.

Students

First Last Grade

ey [N

Note: If a family or student alreadly exists in your new School Management,
this import will not merge with the existing student’s data. This import will
create a new record of that family and or student.

Import PACEs as Billed

(@) es (Suggested) (O No  What's this?

1.0.0.47

Step 3 — Import

Step 2 - Select Families and Students to Impert [ Back | [ Impon

During this process the families and students you selected will be imported and the progress will
display. Dialog boxes may ask for input throughout the process.
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» Link or Add a Subject — This message will appear if a subject from your School of Tomorrow
Management System records is not found in School Management.

School Management - ART Mot Found

You are attempting to import ART from your old records_ This subject
could not be found_ Choose an option below_

) PACE @ MNon-PACE

O Link ART

Acceszones and Supplies - Accessores and Suppliss "
Electives - Choose At

Electives - Health

Electives - Miracles of Jesus
Electives - Miracles of Jesus
Electives - New Testament Survey
Electives - PE 10

Electives - PE 10

Electives - PE 10

Electives - PE 11

Electives - PE12

Electives -PES

Electives -PE S

Electives - PES

English - English

English - English

English - English 10

English - English 10 &

m

["] Remember this link for ather students with ART

@ Add ART as a New Subject

» Enter a Subject Grade — This message will appear if a student’s subject does not have a valid
grade to import into School Management. Review the student’s past records to determine what
grade to input.

Siciuoc] M anagarseat - Erfer & Subject Grads

Bible Reading for Bocky McMercy does not have a grade. A
ﬁudunwhummudfmﬂﬁasubjmhu{muhmnbu
ported. Choose an oplion bekosr,

{7 Use a Letter Grade

# Use a Parcantage Grade

Corilinus

» Enter a Valid Date — This will appear if an invalid date is encountered during the import. You
will need to enter a correct date.
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School Management - Enter a Valid Date

The date of 1/1/1800 i= not a valid bithdate for Ace
Virtueson_ Please enter a new date.

Enter a valid date: |

Step 4 — Review

A final report displays three lists to indicate any errors within the import. You will need to manually add
those items to School Management. It is very important that you write down any errors before
closing the STMS Data Import.

School Management - Data Import Cancel [8]

The import wizard has completed successfully. There are a few notes about the import below.

Student BErors Subject Brors PACE Ermors

There was an emor importing these There was an emor importing these There was an emor importing these
students. You need to write down subjects. You need to write down PACEs. You need to write down this
this list and manually add these this list and manually add these list and manually add these PACEs
studerts. subjects to the students. to the students.

Pudge Meekway Math = Pudge Meekway English - 50
Pudge Meskway English — Pudge Meskway English - 55 —
Pudge Meekway Social Studies |E| Fudge Meskway English - 54 |J
Pudge Meekway Science = Pudge Meekway English - 53

Pudge Meskway Word Building Pudge Meskway English - 51
Pudge Meekway P.E. G1 Pudge Meekway English - 49
Pudge Meekway Math Pudge Meekway English - 48
Pudge Meskway English Pudge Meskway English - 47
Pudge Meekway Social Studies Pudge Meekway English - 46
Pudge Meekway Science Pudge Meekway English - 45
Pudge Meskway Word Building Pudge Meskway English - 44
Pudge Meekway P.E. G3 Pudge Meekway English - 56
Pudge Meekway Music-Vocal Pudge Meekway English - 57

.

Pudge Meekway P.E. G4 B Pudge Meekway English - 52
] [ | 3 < n | ¥

w0047

Step 4 - Review | Back |

Follow-Up
After running the STMS Data Import, you are now ready to finish setting up School Management.

» Assign a staff member and a Learning Center for each student. This must be done since
STMS Data Import assigns all students to the School Management default staff member. If you
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have multiple supervisors, assign each student to the proper supervisor. This can be done on
the student’s enroliment screen for the current year. Previous years are assigned to the default
supervisor.

The School of Tomorrow Management System program defaulted to a 3.0 GPA and used a
grading scale that did not allow pluses and minuses (A-, B+, B-, C+, C-) for PACE scores. The
School Management program defaults to a 4.0 GPA and does allow pluses and minuses for
PACE scores. Because of this upgrade, the GPA for a particular student in a particular year in
School of Tomorrow Management System may be slightly different than the GPA for the same
student in the same year in School Management. This is not an error; it is the result of an
upgraded method of calculation.

Carefully check each high school student’s Academic Projection.

o Any incorrect subjects can be deleted or edited in the Graduation Requirements section of
the Academic Projection.

o Since non-PACE subjects entered in School of Tomorrow Management System do not have
a completion date, any non-PACE subjects listed as Current on the Academic Projection
in School of Tomorrow Management System are imported into the academic year you set
as the current year when you set up School Management. (For example, if you select the
2022-2023 school year as your current year in Setup of School Management, non-PACE
subjects listed as Current on the Academic Projection in School of Tomorrow Management
System will be imported into that year, regardless of the actual school year in which they
were completed.)

Following the completion of the import process, a Supervisor’s Progress Report and a
Permanent Record will be available for all previous years a student was enrolled in your
school. Transcripts will be available for all current high school students. Kindergarten Progress
Reports and ABCs Progress Reports will not display completed PACEs. The Student Progress
Report will only display completed PACEs for the current academic year.
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Set each family’s billing plan. The STMS Data Import assigns each family to your first billing
plan. If you have multiple billing plans, review each family in the Browse Families menu item to
verify that they are properly assigned.

Inventory is not imported through STMS Data Import. Any PACE prescribed to a student
in School Management that is not complete must be manually added into inventory before
placing orders. See page 85 for the steps to add PACEs to inventory.

Before importing any records, the STMS Data Import first makes a backup of your School
Management records. This can be very helpful if you make a mistake during the import and
need to undo the changes and run the import again. You can restore the backup in School
Management by opening the Home menu and clicking Backup/Restore. With this in mind, you
can import your School of Tomorrow Management System records, use the program for a while
to become comfortable with it, and then restore the backup to start over.

If your current backup from School of Tomorrow Management System only contains current
students, you can run the STMS Data Import multiple times with older backups to import other
students. Keep in mind that if you import a family multiple times, duplicate families will display
in School Management. You will need to delete the duplicates.
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Chapter 6
Home Section

The Home section is displayed each time you start the aceconnect School Management client.
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Dashboard

The Home section first displays the Dashboard, providing a quick view of Scripture Due and
Homework Due.

Resources
Manage resource books with this option.
To add a new resource item, click New and enter the appropriate information. (“Book No.” can be

used to identify multiple copies of the same title. “Location” would be the room where the book is
stored when not checked out by a student.) Click Save to store the added resource book.
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To check out a book, select a student name.

Click Check In when the resource book is returned to remove the “CO Date” and student name from
“Checked Out” (will be reset to Not Checked Out as above).

To edit a resource, click on the item and modify the desired information.

To delete a resource, select the item and click Delete.

Find People

The Find People screen provides a searchable list of all the people (staff, students, family members,
etc.) in your database.

B il M BT,

44 Highland School
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All individuals show on the list, but the visible list can be limited by typing in the line below the column
name. It defaults to show all entries that “contain” what is typed, and only entries matching criteria are
displayed in the data grid. Clicking the icon at the left of the column in which you typed can change
the kind of search (“Begins with,” “Ends with,” “Equals,” etc.).

Click Edit to see more about the highlighted individual. The Edit Person dialog box will display.
Additional information may be viewed and, if desired, edited and saved.

Backup/Restore

To create a backup file or restore the program database from a backup file, click Backup/Restore. A
list of backup files in the default location will display.
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To create a backup file of your database, click Backup at the top. When you choose Backup
Database Now from the Backup dialog box, you can choose to back up to the default location

(folder on the hard drive of the SMS Server with files visible in the list of backup files) or to a custom
location (allowing you to create the backup file in another folder on the computer, network, flash
drive, or external hard drive). NOTE: The Custom Location option will only work from the SMS Server
computer.
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To restore a backup, select it in the list and click Restore. Choose Restore Database Now on the
dialog displayed.

WARNING: Restoring a database backup file will overwrite any existing
database information.

When you click Restore, you can also click Browse for Other Backup File and select a backup you
have saved in another folder on the computer, network, flash drive, or external hard drive.

To delete an existing backup, select the backup in the list and click Delete.

Shutdown

The Shutdown feature allows you to shut down the SMS Server for maintenance. A message will be
sent to all connected SMS client computers. It is not recommended that you use this feature unless
directed by Technical Support.

License

School Management requires a valid license file to be fully functional. As outlined on page 13,
License is the screen where you can manage your license file and Portal connection. Your Portal
User Name and Portal Password stored here must match those used on the Portal website
studentmanage.com for Portal Account Status to be "Success."

NOTE: Your school name is automatically set in the program from your license file. To change it,
contact Technical Support for help to update the license and Download License again.


http://studentmanage.com
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Portal Settings

The Portal is the communications site for schools with a valid license to use their Portal user name
and Portal password to communicate with A.C.E. The account information used to log on at the Portal
website (studentmanage.com) should be stored in the School Management database for your school

so the Portal Account Status will be "Success," signifying that the software is connected as your
school.
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With Portal Account Status as "Success," selecting Enable Catalog Updates and Electronic Orders
allows the software to use the connection to help you with keeping up to date.

* You can use the Update Now button to request the current catalog information specific

for your school at any time. Setting an Update Daily at time downloads the updates at the
selected time each day.

At login, the version running is compared with the Latest Version available through the Portal.
When a newer (higher numbered) version of the software is released, an Update Available

notification will display in the top right of the School Management window where the version
number usually displays.
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Families Section

Families must be entered in School Management before adding students. Families are added, edited,
and managed from the Families menu. NOTE: A billing plan must be set up before adding families.

See page 75.

Browse Families

The Browse Families feature provides a quick view of all families. Families are added, edited, and
deleted here.
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Adding a Family

To add a family, click New Family Wizard. The following steps will display. NOTE: Items in bold in the
wizard are required fields.

* Adding a new family — This is the startup screen for the wizard. Click Next.

Adding a new family
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* The Add New Family dialog box will appear.
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+ Primary Person — Enter the information for the head of the family and click Next.

» Secondary Person — Enter information for the secondary adult for the family (not required) and
click Next.

Billing Information — Select the mailing address and choose a Billing Plan. Click Next.
Students — Enter student information. Including Level and Supervisor enrolls the student in the
current year. To enter multiple students, click the green + icon. To remove a student, click the
red x icon. When you have finished entering students, click Next.

Ready to Create Family — Review the summary of actions to be taken. If correct, click Finish.

Editing a Family

To edit an existing family, select the family in the list and click Edit. Enter text in the following fields in
the Edit Family dialog box.

* Primary Person — Click & at the end of the name field to select a person or to add a new
person. Click the pencil h’J to edit the current person’s information. A primary person is
required for each family.

» Secondary Person — Click W at the end of the name field to select a person or to add a new
person. Click the pencil h’J to edit the current person’s information. Click Lﬁ to delete the
secondary person.
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Mailing Address — Select an address from the dropdown list. Addresses entered for the primary

and secondary persons are displayed.

Billing Plan — Select a billing plan from the dropdown list.

Billing Name — The billing name for the family is created automatically from the names of the
primary and secondary persons, but the billing name can be entered as desired. Clicking
Automatically Set Billing Name returns Billing Name to the default setting.

Students Tab — Add and manage student information for the family. It is important that you
click Edit on the Students tab, then click the Address tab and select the appropriate mailing
address. The program defaults to Use Custom Address and will print blank student address

labels if an address is not selected.
Notes Tab — Add notes for the family.

Primary Person |'\|"||'1Llest:|'|r Mr. David a_@ Billing Plan |Churr.:h Member a_!
Secondary Person |'\|"|rtueson, Mrs. Faith @Q@ Billing Name |'\|"||'1Llesc:|'|r Mr. David and Mrs, Faith |

Mailing Address |H0me - Virtueson, Mr. David @ I Automatically Set Biling Name J
J_Smdent;- Notes
i I:E:I Mew j Edit $& Remove
|| Student Name iLevel | Status i

l. » | Virtueson, Ace Junior
Wiling, Hudson 1st Level
st Level

' wiling, Judson

Enrolled
Enrolled
Enrolled

Save J I Done J
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Deleting a Family

To delete a family, select the family in the list and click Delete. A confirmation dialog box will be
presented.

Family =
|\ Delete Family Lovejoy, Mr. Robert and Mrs. Rachel?

= Delete

All associated children/students, billing transactiens, and billing history will also be
deleted. This action cannot be undone!

Cancel

Click Delete and the family will be removed.

Important: Deleting a family will cause all associated children/students
and their academic information to be deleted as well. This action
cannot be undone.
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Chapter 8

Students Section

Academic components are managed and tracked in School Management in a variety of ways. The
student must be added before entering and managing student data. The Add Student menu item can
be accessed in one of two ways:

+ |tis always recommended that students be added in connection to a family. Students are
enrolled in the Families section (previous chapter) when the family is first added. To add a
student to an existing family, edit the family by clicking New in the Students area.

» Though not recommended, the Students —3 Browse Students page has an option to click
New for the Add Student dialog box to appear.

Progress Control

The Progress Control page is where each student’s subjects and scores are entered. The Academic
Year dropdown list defaults to the current academic year but also allows you to view previous
academic years. When a student is selected, the grade level for the selected academic year displays
in the header row.
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To view subjects and scores, select the desired student from the dropdown list. Once a student’s
information is added, his subjects and assigned PACEs will display. Each PACE is color coded by
status—Prescribed, Issued, Ordered, In Stock, Passed, or Failed.

Biclogy

Score | 970 1000 96.0 920 93.0 970
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The following menu items are included on the Progress Control page:

* New Subject — Click to add a new subject for a student. A Student Subjects dialog box will

display.

Non-High School Student

rudent Subjects
Subject Type | ¥
Subject | QJ
Display Name | |
No. of PACEs/UNits | 125
Starting PACE/Unit | 1001 {5
Ordering Prerequisite | @
L Save I I I Cancel

High School Student

StuiencSibets T B—|
: ; Remaining Graduation Requirements
Subject Type | QJ -
| Subject 'Req. Credits |
Subject | ®] ~ g
Display Name | | Algebra 11 100 &
Mo. of PACEs/Units g || Geometry 1.00
Starting PACE/Unit | 1001 5 [ Trigonometry 0.50
= English I 1.00
Ordering Prerequisite | @ — g . --Bi
|| Save I J I Cancel

Select the Subject Type from the dropdown list to populate the available subjects; then choose
the desired subject. The Display Name defaults to the subject name and is how this subject
will appear on this student’s reports, but it may be individualized. Select the No. of PACEs/
Units and Starting PACE/Unit.

The Ordering Prerequisite dropdown list allows you to choose to prevent School Management
from ordering two subjects within a subject type at the same time. For instance, if you do

not want to automatically order Geometry PACEs until Algebra | PACEs are complete, select
Algebra | from the dropdown list when adding Geometry. Leave this value empty if it does not

apply.

Click Save to add the subject.
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* New PACE - Click to add PACEs to the current subject, such as gap PACEs. The Add PACE
dialog box will appear. Enter the Starting PACE/Unit number (defaults to the next PACE not
prescribed) and the No. (of PACEs) to Add. Click Insert to add the score boxes.

Subject | _J

Starting PACE/UNit | 1042 (5
No. to Add 18

I Insert H Cancel J

+ Delete PACE — Click to delete a PACE. Make sure to click on the PACE you wish to delete

prior to clicking Delete. A confirmation dialog box will display, allowing you to confirm the
delete.

Confirmation

o Drelete item 1030 for Literature and Creative Writing?

| Yes I | Mo |

» Acad. Year — Defaults to the current academic year. Other years are accessible using this
dropdown list.

+ Grade Level — Displays the student’s grade level corresponding to the academic year selected.

* Add Completed Subjects — The Add Completed Subject(s) wizard will walk you through the
process of adding subjects and scores to past years with just the final average or letter grade.

Add'COﬂI P e eyl

orkisr 1

Subject Information
Enter information for the subject(s) being added.

Subject Type Subject Is Transfer?  Credits Average  Grade Academic Year

L | b vew O ves@mo | 100 | [100 ] or 20305031
CE
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NOTE: If a letter grade is added in the Grade field, the letter grade will override a numerical
grade entered in the Average field.

Ordering Rules — These settings default to the school settings on the Inventory —3 Subject
Ordering Rules page. If a student is using a different edition, use this button to edit the
Preferred Edition field of the subject you wish to change.
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Subject Names/Buttons — Each subject name is a clickable button, allowing you to edit the
existing subject. Click the subject name to open the Student Subjects dialog box. Modify the
values as desired and click Save.

Run Report — The right panel displays shortcuts to applicable reports for the student. Click any
link to run that report for the selected student.

Editing Items in Progress Control

After PACEs/Units have been prescribed to a student in Progress Control, they may be edited by
right-clicking the item to display a pop-up menu.

Issue
Assign
Un-lssue

Mark as In Stock

Delete

Cancel

The options work as follows:

+ Issue — This allows you to issue the item to the student. This should be done when you are
physically handing the PACE to the student. A PACE can only be issued if it is available in
inventory. If your School Management user account has administrator permissions or has
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permission to “Override Inventory,” you can override the requirement to have the PACE in
inventory before issuing. The PACE is not subtracted from inventory. Caution should be used
when overriding inventory to avoid causing errors in inventory amounts. Non-PACE subjects
are issued without being tracked in inventory.

» Assign — This option will reserve the PACE in your inventory for the selected student.

* Un-Issue — This allows you to un-issue a PACE for a student and adds it back into the
available inventory. If the PACE was issued by overriding the inventory, it is not added back
into the available inventory.

» Mark as In Stock — This adds a copy of that PACE item into the inventory assigned to the
current student so that it appears in the “In Stock” color.

* Mark as Not In Stock — This removes the copy of the PACE item assigned to the current
student from the inventory so that it will no longer appear as “In Stock.”

» Mark as Passed / Mark as Failed — When a score is entered, School Management will
automatically mark the item as passed or failed according to the “Min. Passing Score” set for
the subject through the Setup =3 Subjects list. This option allows you to switch the status
of a PACE from failed to passed or from passed to failed respectively.

+ Completion Date — The completion date is automatically set as the date you enter the score. If
needing to change the completion date of an item, select this option and enter the alternative

date.
+ Delete — This option deletes the selected item from the student’s records but does not alter the
inventory.

» Cancel — This option closes the menu.

Adding Basic Literature 7 and 8 to Progress Control

Basic Literature 7 and 8 must be added as non-PACE subjects to allow you to enter grades for each
individual Study Guide.

* First, add the non:PACE gubject to your schoc?l’s datapase: From NOTE: Because Basic
Setup —> Subjects, click New. Enter a unique subject name Literature 7 and 8 are set up
(such as Literature 7 or Literature 8), select the Literature and as non-PACE subjects, they
Creative Writing subject type from the dropdown list, and enter 12 | have to be billed manually.

PACEs/Units per 1.0 credit(s). Click the Is PACE box to remove the
default checkmark. Enter the starting and ending PACE/Unit for the level and click Save.
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MName | Literature 7

Subject Type |Literature and Creative Writing

&

12 @ PACEs/Units per 1 Q credit(s)

Is PACE []
Is Assignable

GPA Weight %  Starting PACE/Unit

Ending PACE/Unit

Min. Passing Score

1074 |=
1054

22

a0

L

Save

/|

Cancel

=)

« With the non-PACE subiject in the school’s settings, it can now be added to Students —>
Progress Control to record scores. Click New Subject to select Literature and Creative
Writing as the Subject Type and then the new, non-PACE subject from the dropdown list. Set
the No. of PACEs/Units to 12, and verify the Starting PACE/Unit. Click Save and the subject

will display in Progress Control.
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+ Literature 7 and 8 do not have tests for all the PACE numbers of the levels. Right-click each
PACE/Unit number not needed to choose Delete.

Quick Score Entry

This screen provides an entry point for the scores of the currently issued PACE/Unit for multiple
students or multiple subjects on one screen. The screen initially opens with one line that can be filled
in from left to right with the Student, Subject, PACE/Unit, and Score. The Completion Date defaults
to the day of entry, but the Completed column can be edited if necessary. To add an additional line to
enter another score for a different subject and/or student, click “+ Add” at the top.
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3 WVaeson: 1.9.6951 Logout

«24%. Highland School s s
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Attendance

Note: While entries will remain visible on this screen during the same logged in session, scores are
not written to students’ records until the Save option is clicked. Both the Save and Clear option clear
all entries.

Academic Projection

In Academic Projection, each student’s high school graduation requirements, listing subjects to be
awarded high school credit, are managed. The Graduation Requirements area is where most of the
editing takes place, with Current Year Subjects, Credits/GPA, and Previously Completed Subjects
areas.
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Assigning a Course of Study

First, fill in options across the top. If not already selected, choose a student from the dropdown list.

To assign or change a student’s course of study, make a selection from the dropdown list. Assigning a

course of study puts its required subjects into the student’s Graduation Requirements list.
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To remove a student’s assigned course of study, click Remove. After confirmation, all graduation
requirements (including any that have been added) will be removed.

Click the Active button to allow not only enrolled students but all students with records to be selected
from the Student list.

Add a new subject to the Graduation Requirements list by clicking Add in the menu bar. Enter the
credits and subject.

Delete an existing graduation requirement by selecting the subject on the list and clicking Delete in
the menu bar.

Graduation Requirements

The individualized graduation requirements for the selected student display in the Graduation
Requirements area. This list includes columns for Credits, Subject, and Required.

Only subjects included in the Graduation Requirements list of
the student’s Academic Projection will be awarded high school Graduation Requirements
credit and appear on the student’s transcript. Subjects added to the grid affect the selected
graduation requirements by the course of study will have a checkmark in student only. Modifications
the Required column. Use the Add option at the top to add subjects to the | in this section do not change
Graduation Requirements list for high school credit and appearance on f/r:u(;:“rse of Study default
the student’s transcript. :

NOTE: Items modified in the

For example, the College Preparatory Course of Study requires New Testament Survey as a Bible
elective. However, a student may also take Old Testament Survey. Old Testament Survey must be
added to graduation requirements for that student, or high school credit will not be given and the
course will not display on the transcript.

The program highlights lines in the Graduation Requirements list in blue or green to indicate which
subjects have scores in the current or previous academic years.

The student is automatically given high school credit as he completes PACEs or Non-PACE Units that
match his graduation requirements. In some cases the program is not able to assign these credits
automatically. In those situations you can manually link the PACE/Unit scores to the graduation
requirement in order to give credit. Some examples of when you might need to link subjects are as
follows:
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* You are awarding high school credit to a vocational student for PACEs below 1097 (such as
linking Math PACEs 1091-1096 scores to a Math Graduation Requirement for a half credit).

» A student transfers a subject from another school and space. (Example: English | was added
for a student as a completed transfer subject. You would link the score in his records named
English I* to the English | Graduation Requirement to indicate he met the requirement.)

To link specific subject scores to a graduation requirement, right-click the subject in the requirements
list and click Link Completed Subjects. A form will display showing all completed PACEs/Units of
that subject type. Check the Link column for each score to link it to the graduation requirement and
click Save.
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Current Year Subjects
Subject and Credits columns display in the Current Year Subjects grid. The Credits column shows the
number of credits completed and the number of credits possible for each subject.

Previously Completed Subjects
Subjects with scores in previous years display in the Previously Completed Subjects area. This area
includes Credits, Subject, Average, and (academic year) Completed.
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» The Credits column displays awarded credits. In order for the student to receive credit for
previously completed subjects, the subjects must be listed in the Graduation Requirements list.

* You can right-click a line to choose Change Subject Name from the pop-up menu. A dialog
box displays that will prompt you for the new name. Enter the desired name and click Save.

| Description for: Algebra IT @
Mew Name |AIgEI:|ra 1| |

I Save H Cancel J

Credits/GPA
This area displays information related to the student’s required credits and GPA.

* Required — The number of base credits required for graduation for the course of study

» Electives — The number of elective credits required for graduation

» Total Required — The total number of credits required for graduation. This value can be
modified by entering a new value. NOTE: Modifying the total required credits will automatically
recalculate the values in this area.

Kindergarten

This menu item is only enabled when a student is enrolled in a grade level that allows the
Kindergarten program.

Kindergarten Lessons

The first time the Kindergarten menu item is accessed for a student, you will be asked if you wish

to add Kindergarten lessons. Kindergarten lessons must be added to make use of the Kindergarten
Progress Report for this student. Choose Add to assign the lessons. For each lesson displayed, the
following areas are available for review.

+ Sound Recognition
Auditory Comprehension
Oral Work

Physical Development
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Review values for each area are entered using the scale below.

E — Excellent

G - Good

+ S - Satisfactory

* N — Needs Improvement

NOTE: Grades entered for Kindergarten lessons do not save automatically. Make certain to click
Save before closing or all grades entered will be lost.

ABCs

This menu item is only enabled when a student is enrolled in a grade level that allows the ABCs
program.

ABCs Lessons

The first time the ABCs menu item is accessed for a student, you will be asked if you wish to add
ABCs lessons. ABCs lessons must be added to make use of the ABCs Progress Report for the
student. Choose Add to assign the lessons. For each lesson displayed, the following areas are
available for review.

+ Letter Recognition

* Sounding of Letter

+ Letter Formation

» Blending of Sounds

* Physical Development

» Bible Memorization (for reference only—this item is not reviewed)
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Review values for each area are entered using the scale below.

E — Excellent

G - Good

+ S - Satisfactory

* N — Needs Improvement
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NOTE: Grades entered for ABCs lessons do not save automatically. Make certain to click Save before
closing or all grades entered will be lost.

Post Test

Enter the Post Test Score and the Post Test Date in the header row. These items are automatically
saved when entered.

Attendance

School Management offers two options in the Students section for entering attendance: Attendance
page and Goal Check page.

The Attendance page allows the logged-in staff member to see all of his students (or All Students by
checking the box) for the selected school day to set the attendance for each of them.

Stedents Dalr | 1150072 o LA Sudents g®
e B LB il
Quick Sae Entry Loy, Chvist @ Present 1) Abwert (5] () A (U0 Terdy (E) (0 Tordy (L) ) Sumpended
e Ay . @ Bressnt ) Mbewot ) 0 beant 1) ) Tovety (1) Q) Tovdy (U] (D) armpenced
TR Crresent ) pmsern i) O Assert (U0 Teraty (5} 3D Tordy () ) Sumperces
[FES—— @ bresert 1)t (F) 0 At () C) Fovity () (20 Tovdy (1] () e
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sl Clack
Femeark Adsonment
Mesits and Denetiis

By default the date is set to the current day. If the date is not a school day, Not a valid School Day
shows with no students listed.

Date | 7/4/2022 Qf| |_|All Students ;,'l Mot a valid School Day

| Student Full Name | Status

The date can be changed by typing a date into the field or using the dropdown calendar. The
following values are available to set for each student’s attendance that school day. Values are saved
automatically.

* Present — The default selection for each student
» Absent (E) — Excused absence

» Absent (U) — Unexcused absence

+ Tardy (E) — Excused tardy

* Tardy (U) — Unexcused tardy

» Suspended

Attendance may also be entered for specific students on the Goal Check page.
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Goal Check

Use the Goal Check page to enter goal check information for a specific student. Select the student
from the appropriate dropdown list. The Week Including date defaults to the current day but may be
changed as needed.
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Entering Attendance Information

With the student selected and current day selected in the Week Including field, select the attendance
status for the day in the Attendance area.

Entering Goal Check Information

The student’s subjects display for the Goal Check status to be selected from the dropdown list for
each day of the week for each subject. Selections are saved automatically.

Adding a Homework Assignment

Homework assignments can be added from the Goal Check page or from the Homework
Assignments page.

From the Goal Check page, add a homework assignment for a selected student by selecting New
beside the Homework Assignment header. The Add New Homework Assignment form will display with
the selected student filled in.
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Student [Virtuese || assigned on [8/11/2022 %]
Subject | %] Due On [8/11/2022 &

Task | |

From Page l:l To Page l:l
Notes =
Signed On [Not Signed ] Isprinted []
Completed On Mot Completed ) -~ [ pone|

Enter necessary information into each field:

» Assigned On — Defaults to the current date

* Due On — Select the date following the Assigned On date. NOTE: Dates can be changed by
typing the desired date or by using the dropdown calendar.

+ Subject — Select a subject from the dropdown list.

» Task — Defaults to Finish Goal Pages. Modify this field by typing in a different task.

+ From Page / To Page — Enter the pages of homework.

* Notes — Type a message about the assignment to print on the Homework Assignment report if
desired.

Click Save when all information has been entered. If the selected student has homework in other
subjects, add it by following the above steps. When all homework for the selected student has been
entered, click Done.

| HOMEWORK ASSIGNMENT | oh New /7 Edit 3% Delete

_G_oal Subject Goal Task

=
| ¥ | Sdence
English

| Completed On | From Page ToPage  Signed On

| s @™
10

12

m|

Finish Goal Pages

A line for each homework assignment will appear in the Homework Assignment area.

To edit a homework assignment, select the line and click Edit. Edit Homework Assignment will
open to let you make necessary changes and click Save. When finished, click Done to close Edit
Homework Assignment.

Click Delete to delete the selected homework assignment.

(Homework may also be managed on the Students —3> Homework Assignment page.)

Student Notes

Student notes are managed in the bottom area. There are three display options.
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* Goal Notes — The default display shows notes of the Goal Notes type for the selected student.
» Merits and Demerits — Click to display a list of notes for this student with merits and demerits.
» All Notes — Click to display notes of all types for the selected student.

Options are given to edit notes, add new notes, or delete notes.

* New — Used to add a note for the selected student. Add Note will display for you to use the
dropdown lists to select the Date, Note Type, and Note Subtype. Type the content of the
note in the text box and then click Save. The note will appear in the Notes list (if the display
selection matches).

» Edit — Used to edit the note for the selected line

* Delete — Removes the selected note (when confirmed)

Homework Assignment

Homework assignments for all students can be managed on this page. By default, only incomplete
homework assignments are displayed. To show all assignments, click Show Completed at the top.
Other options at the top are:

* New — Will display Add New Homework Assignment containing these fields: Student, Subject,
Task, Assigned On, Due On, From Page, To Page, Notes, Signed On, Completed On, and Is

Printed
nment -g'

Student | @ Assignedon /1112022 ¥
Subject | g Due On [8/11/2022 =)

Task | |
Motes '~
Signed On [Nt Signed %] IsPrinted ]
Completed On |Not Completed ng - | I Done J

Enter the appropriate values and click Save to create the printable Homework Assignment.

+ Edit — Displays Edit Homework Assignment to make changes to the selected assignment. After
making edits, click Save.
* Delete — Removes the selected assignment (when confirmed)
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selected (highlighted) line

* Print Unprinted — Prints homework assignment reports for all homework assignments with

Printed unchecked

Merits and Demerits

Merits and demerits are added through the student notes and are managed on this page. Select a
list to work with the notes with merits or demerits for the student.

student from the dropdown

* New — Opens the Add Note form. Selecting a Note Type (like Goals) that allows for merits and/
fields and allow you to enter a value. Complete all fields and click Save.
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« Edit — Opens Edit Existing Note to make changes to the selected note. Click Save to store the

changes.

* Delete — Removes the selected note (when confirmed)



. 66
“@ronnec?

Scripture Memory

Manage Scripture Memory assignments on this page. All assignments for the current year will be
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The actions available on the Scripture Memory page are:

* New — Opens Add New Scripture Assignment to create a new Scripture Memory passage to

assign to students

« Edit — Opens Edit Scripture Assignment for the selected passage (to change or record
completion for students)

* Delete — Removes selected passage (when confirmed)

+ Filter — Select this to toggle between Just My Students or All Students in the Scripture

assignment grid.

Add/Edit Scripture Assignment
When adding or editing a Scripture Memory assignment, the following fields can be modified:

» Passage — Enter the Scripture reference.
» Start Date — Enter the date by typing or select using the dropdown calendar.
* Due Date — Enter the date by typing or select using the dropdown calendar.
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Click Assign To for options to assign the Scripture to My Students, All Current Students, Select
(individual) Student, or Select Learning Center.

To unassign a student, select the student and click Unassign.

To enter a completion date for a student, edit the Completed Date field by the student’s name by
typing the date or select the date using the dropdown calendar. Click Save when you have finished

modifying items.

Desirable Traits

Enter the Desirable Traits scoring for each student on this page.
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Select the desired student from the Student dropdown list. Lines for each desirable trait are displayed
with names at the left and columns to enter scores for each academic year period. Enter values in the

columns using the following scale:

E — Excellent

G - Good

+ S - Satisfactory

* N — Needs Improvement

Entered items are automatically saved.
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Standardized Testing

The Standardized Testing page allows you to record standardized test scores for students. Before
entering scores, you must configure Standardized Tests in the Setup section. See page 30.

* New — Click New to display the Add New Standardized Test Score form.
o Student — Select a student to add scores.
o Test — Select the standardized test for which you are adding scores.
o Taken On — Select the date the test was taken.
o Score Areas — Enter the score for each section. Click Save.
« Edit — To edit an existing test record, select the line and click Edit. The Edit Standardized Test
form displays. Make all changes and click Save.
+ Delete — Select the line of the test record you wish to delete, click Delete, and confirm.

Privilege Status

The Privilege Status page allows for quick entry of weekly privilege status for all students.

2ol Hansgernent = S S
T wasors LBTH L
=8, Highland School
et 3w

Sudente & Qe Roam L =

] Shek Frnieqes Siskn ek CF o

e Seore Enay ¥ o, A E Haxn | eiaEe

e | dE | B 1

Action options for the Privilege Status page are:

* Add - Puts an additional entry line on the page. Enter columns on each line by selecting a
student and privilege status from the dropdown lists. The Week Of field defaults to the current
date but can be changed.

* Clear — Clears all data from the Privilege Status page

+ Save — Stores the visible entries as student notes
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Entries only show on the Privilege Status page while being entered. When saved, Privilege Status
is stored as a Privilege Note for each student. Privilege status notes can be seen in Students —>
Goal Check in the Notes area by clicking All Notes. The Privilege Note type will display with the
letter selected as Detail.

GOALNOTES MERITS AND DEMERITS l%IIOTE“ oo New 7 Edit §3 Delete
"_ Date Created By Note Type Detail MNote
I'_ 8f26/2022 admin Privilege E

Browse Students
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The Browse Students page allows for a quick view of all students by academic year.
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It defaults to the current year, but selecting another year in the Acad. Year dropdown list will display
the students for that academic year.

Note: Browse Students defaults to show only enrolled students grouped by supervisor. The filter
button can be used to change which students are displayed and how/if they are grouped.
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Action options for the Browse Students page are:

* New — Opens Add Student to create a new student (It is recommended to create students
through Families rather than using this option.)

« Edit — Displays the Edit Student form, allowing the user to make changes to the student’s
information

» Delete — Permanently removes all records of the selected student

Adding a Student

Click New for Add Student to create a new student. (It is best to create students through Families to
ensure that important connection.) Edit the fields as outlined below and click Save. (Clicking Done
closes without saving entries.)

Editing a Student

Click Edit to open Edit Student to alter the information for the student highlighted in the list. The top
portion of Edit Student (or Add Student) has the following fields to enter information (bold fields are
required):

* First Name

* Middle Name

* Last Name

* Family (select from existing families)
* Gender

+ Birthday

» Student ID

» Citizenship

* Graduation Date

* Withdrawal Date

Additionally, there is a frame for including a picture in the upper left. Right-click inside the frame for
options to load an image from a file or paste a copied image.

First Masnwe | Hudson Gerider |M kd
Maklle Hane B lhutay | 552006 [
[aone] Last Hame |Wiing Shident 10 )
Famdy [Vebaeson, M. Dawdan... | Citieerrbin | B26 6 6A6A
Cenduuniion Omtr | o
\ithdrawal Date I
|| Lovets Tt || Peltimmdage: | Gombact Tl Ackbe |
'..:__'r-u Fracil 3 Withclras = .
s ey e e ok Erwclber Dl
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The bottom portion of Edit Student (or Add Student) has the following tabs for accessing additional
student information:

Levels
This tab displays lines for each year/level the student has records. Each line has information for
Academic Year, Level, Supervisor, Enroliment Status, and Enroliment Date.

» To enroll the student in a new level, click Enroll and enter information for all columns of the
added line.

+ To withdraw the student who leaves before the end of a school year, click the line for the level
and click Withdraw. The option will be given to withdraw or delete the student from the year. If
the student has records in the year, Withdraw is recommended to retain records.

Notes
This tab displays the notes for the student.

* To add a note, click New and enter the note information in the Add Note form.
» To edit an existing note, select the note and click Edit.
* To delete an existing note, select the note and click Delete.

Relationships
This tab displays relationships for the student.

» To add a relationship, click New. Select a person (or add a person) using the & button. Set
the Relationship and Guardian, Pickup, and Medical privileges; then click Save.

+ To delete a relationship, click the line of the relationship to highlight it, click Delete, and
confirm.

Contact Info
This tab displays fields for the contact information listed below.

* Cell Phone * Email Address
* Home Phone * Twitter
* Work Phone » Facebook

* Other Phone * Website
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Address

This tab displays addresses for a student. If a guardian is defined in Relationship, you can use his
address for the student, or enter a custom address for the student.

Final Edit Student Reminder: Click Save to close Edit Student and save any changes. Clicking
Done or the X to close will not save any changes.

Deleting a Student

To delete an existing student, select the student and click Delete. This action will delete all existing
information for the student, including school progress, grades, notes, and anything else you have
entered for that student. IMPORTANT: This action is permanent and cannot be undone!
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Chapter 9
Billing Section

Family account balances, financial transactions, and billing activity are managed on the pages of the
Billing section.

Balances

The Balances page allows you to view the current outstanding balance for each family in School
Management. The Print action option runs the printable Balance Report.

Transactions

The Transactions menu item allows you to view, enter, and manage transactions for a family. Choose
the family account to manage from the Family dropdown list.
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Adding a Manual Transaction

To add a manual transaction, enter the information in the Post Transaction area fields:

» Transaction Date — Date of the transaction (defaults to current date, but can be edited)

*  Amount — Amount of the transaction

» Check No. (optional) — The number of the check, if applicable, when the transaction type is
Payment

» Transaction Type — Type of transaction, including Debit (charge), Payment, or Credit
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» Description — A brief description of the transaction (appears on statement)
+ Details (optional) — A more detailed description of the transaction

Click Save to post the transaction.

Viewing Transactions
The lower half of the Transactions page displays transactions for the currently selected family.
Reversing a Transaction

Reversing a transaction enters a corresponding transaction of the opposite type into the system.
This action has the effect of canceling a previous transaction. To reverse a transaction, select the
transaction in the grid and click Reverse.

Deleting a Transaction

When a transaction is deleted, unlike when reversing a transaction, the record is completely removed.
To delete, select the line of the transaction in the list and click Delete. You will only be allowed

to delete transactions entered since the last billing run (more recent in list than all tuition debit
transactions). Transactions from previous billing runs cannot be deleted.

Billing Runs

The Billing Runs page is the heart of the billing section. The billing run is the monthly process that
posts all tuition and PACE charges since the previous billing run. It also posts and reconciles all
accounts and transactions that have been entered since the last billing run. The page lists previous

billing runs for the current academic year. Family account statements print based on these billing
runs.
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The following actions are available:

* New — Starts the process for a new, monthly billing run. The first option will be to select the
date for the Bill Run (defaults to current, but can be set to a past date) and click Process.

Biling Date |8/12/2022 ©]

L Process I Cancel J

The Bill Run works to apply all transactions to family accounts, apply PACE fees based on Bill

PACEs settings (see page 17), and apply tuition charges based on Billing Plan settings (see
next section). The new billing run will appear on the list, and all transactions included in the
billing run will then be able to appear on the statement report for each family account.

» Delete — Deletes the selected billing run. This action will remove all transactions (calculated or
added) that were posted with the billing run.

Billing Plans

The Billing Plans page displays all billing plans currently configured in School Management.
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The following actions are available:

* New — Opens Add Billing Plan to create a billing plan
» Edit — Allows you to edit the selected billing plan
+ Delete — Allows you to delete the selected billing plan (if not assigned to any families)



/ﬂ 76
~@connect

SCHOOL MANAGEMENT

Adding/Editing a Billing Plan
When adding a new billing plan, enter the Name and the number of Billing Months desired. Click
Save for the additional entry options to appear.

add pling pan . T

Hame | Members

[ Save I I Close J

Billing Months | 10

After saving a new billing plan or editing an existing plan, the following areas and fields are available
for modification:

» Tuition Amounts (Annual) — Allows you to designate the Annual Tuition for each level. To set
all levels the same, enter the Annual Tuition amount in the line at the top of the list, click to
another line, then click Make All Same.

» Discounts — Allows you to add discount percentages for this billing plan (calculated as a
percentage of the annual tuition installment). While the overall annual tuition settings can be
used for a different tuition rate for all families assigned a plan, Discounts allows Statements
to show families their discounts off the tuition charges. For billing plans with discounts, Bill
Runs creates transactions for not only a debit (charge) labeled “Tuition for [Student Name]” for
each student, but also for a credit labeled “Discount” for those that apply. The discount options
available are:

o Overall discount: Will add a credit labeled “Discount for [Student Name]’ to all students in
the family account (can combine with the family’s multiple student discounts below).

o Additional student discounts: For families with more than one child, percentage discounts
for students after the first (up to ten) can be set. Credit transactions are labeled “Discount
for child #.” If you wish to make all discounts the same, enter a value on the 2nd Child line,
and click Make All Same.

* Months to Bill — Allows you to designate which months to bill for tuition. Click the box by the
months you plan to bill tuition. The Billing Months number will update as the number of months
selected changes. This determines the number of installments for the annual tuition. With
Billing Months at 10, a debit for one-tenth the annual tuition would be charged by the bill run
in each checked month. With Billing Months at 4, one-fourth of the annual tuition would be
charged by the bill run in checked months.
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Be sure to click Save when all entries are as desired. (Close will not save entries.)

g

Name |Members

Billing Months @
Tuition Amounts Level Annual Tuition |
(Annual) |
Make Al Same | *|K3 . i
| prek $2,000,00
ke $2,000,00 | _
] ks $2,000.00 4
" 1stLevel $2,000,00
] 2nd Level 52,000.00
] Ird Level £2,000,00
] 4th Level 52,000.00
- 5th Level £2,000.00 @l
voke Al s | Oera 0 g
2nd Child 10 G|% 7t chid |j\ %
wdchid[ 20 G sthchid %
ahchid| 40 )% 9t Chid ﬂ %
sthchid| 60 (% 10th chid %
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Miscellaneous Fees

Miscellaneous fees (non-PACE curriculum charges, graduation fees, activity fees, etc.) can be billed
to a family account several ways.

1. Fees can be charged manually to each individual family to which they apply by adding a

manual debit transaction. See page 73.

2. Fees can also be included with the annual tuition for a specific level within a billing plan that
includes the fee as a part of the families' tuition cost. For example, the annual tuition for 7th
level can be raised to include costs for the non-PACE Basic Literature 7 subject. The cost is
then included in the tuition installments for the student rather than a separate transaction on

any statements.

3. Batch Transactions —

see below
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Batch Transactions

The Batch Transactions page allows you to create transactions that can be entered once and applied
to multiple families or students. This can be used for any transaction that would be applied similarly
to multiple families. Examples are field trip fees, non-PACE curriculum charges, graduation fees, staff
family credits, and scholarships. After adding a batch transaction to the list, it can be used repeatedly,
affecting selected families or students each time.
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The following actions are available:

* New — Opens Batch Transaction to add a new batch transaction to the list
» Edit — Opens Batch Transaction to edit the selected batch transaction
+ Delete — Allows you to delete the selected batch transaction (requires confirmation — cannot be

undone)
* Apply Transaction — Allows you to select the families or students to apply the selected batch
transaction. This adds the transactions to the family accounts.

Adding/Editing a Batch Transaction
When adding or editing a batch transaction, enter data in all the fields and click Save.

action . _d
Description | MNew Batch Transaction |

Amount |U

Apply To |Students ;! Transaction Type |Debit @

Details [ |

Save ] |_ Close J
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When adding or editing a batch transaction, the following fields are available for modification:

» Description — The label for the batch transaction. This is how the transaction will appear when
added to each family’s account (with student name if applicable).

* Amount — Allows you to enter the monetary amount for the batch transaction

* Apply To — Sets whether the batch transaction is a per-student transaction or per-family
transaction. This determines if the list of families or the list of enrolled students displays when
you apply the transaction.

» Transaction Type — Options are Debit (charge), Payment, or Credit.

+ Details — Visible only when editing a batch transaction, this allows you to add notes about the
purpose of and uses for this transaction.

Applying a Batch Transaction

Selecting Apply Transaction allows the selected batch transaction from the list to be applied

to family accounts. Batch Transaction — Apply will open, displaying Description, Amount, and
Transaction Type with options to set the Transaction Date and Applies To list of either students or
families based on the Apply To setting for the selected batch transaction.

Description September Field Trip Fee
Apply To Students Amount 510,00
Transaction Type Debit Transaction Date |8/26/2022 [©]
AppliesTo | iane Famiy Name | Grade Level  Supervisor Apoky ||
unselect 8111 ovejoy, Chist Levejoy, Mr. Riobert .. | Sephomere  Friendson, M. ... | [¥]
| Mcercy, Bedy McMercy, Mr. John a... |dthlevel  Friendson,Mr. ... | ]
|| Metercy, B4 McMercy, Mr, John a... | Senicr Friendson, M. ... | [=]
|| Mtercy, Sandy McMercy, Mr. Johna... Gthlevel  Friendson, Mr. ... &
|| Upright, Reginald Upright, Mr. Charles ... Sophomore  Friendson, Mr. ... ~
| Virtueson, Ace Virtueson, Mr, David ... | Junior Friendson, Mr. ... =
|| Wiling, Hudson Viehreson, Mr. David ... | Istlevel  Content, MissA.. [
B Wiing, Jison Virbueson, Mr, David .. | Istlevel | Content, Mess AL, (IS I
Show Students for | 2022-2023 |
|2022-2023 8 [ e ]| o]

Enter a Transaction Date, select the students or families to apply the transaction to, and click Apply.
This will add the transaction to the account of each selected family (adding the student’'s name with
the Description if it is an Apply To Students transaction).
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Inventory Section

Ordering, inventory, and catalog items are all managed from the Inventory section.

Orders
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The Orders page allows you to create and manage inventory orders. The following actions are
available:

* New — Allows you to create a new automatic or manual inventory order. Create Order will
display with options for your choice (see below).

» Edit — Opens Edit Order to manage the selected order

* Delete — Allows you to delete the selected order (removes all record of the order from your
database, but does not cancel the order with the supplier if transmitted)

Filtering Orders

By default, the Orders page only shows orders from the last 90 days that have not been received. The
filter button on the menu bar allows you to change what orders display. Options selected include a
check mark beside them in the dropdown filter menu. Available filters include:
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* Include Received Orders (on or off)
Only one of the following options:

+ Past 90 Days

+ Past 180 Days

+ Past Year

+ All Past Orders

The Order Status for all listed orders shows where they are in the process. Orders start in the Open
status while being edited. Only open orders can be altered. When editing is completed, orders are
marked with a status as Ready To Send. (An order at Ready To Send can be re-opened to make
changes, but orders with any other status can no longer be returned to Open.) After this, other
statuses signifying the order's state in the process (Printed, Submitted, etc.) appear until the order
becomes Received.

Creating an Automatic Order

Automatic ordering adds PACE items to an order by reviewing the academic prescription for the

selected students. When selecting students, you can change the number of PACEs to “Order Ahead”
for a student.

On an automatic order, you can also check the box to Replenish PACE Inventory to manage the
inventory of extra PACEs available at your school. Selecting this will add to the order any items
needed to bring inventory to the auto-stock level set for each item number in the Inventory > Catalog
screen. See page 87 for editing auto-stock levels.

The PO number is automatically created for you. However, if you wish to create a new PO number,
click the plus button. Finally, click Apply and Order to start the automatic order processing. This will
take you to the Edit Order form with the added items.
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To complete and submit this order, take the following steps:

+ On the By Students tab, a line for each individual item on the order will be listed. Items can be
removed from the order by selecting a line and using the X for Remove.

+ Additional non-PACE items (such as Score Keys, forms, and resource books) can be added
to the order. Click the Add button to add a line, select the Item # from the dropdown list, and
enter the quantity.

» Select a shipping method using the Ship Via dropdown list.

» Select the desired shipping address from the Shipping Address dropdown list.

+ If this order will be submitted via the Internet from School Management, make sure the Send
via Web check box is selected.

» Click Ready to Send to prepare the order for submission.

Creating a Manual Order

Manual ordering is for ordering Non-PACE items from A.C.E. or creating an order for materials from
other suppliers. To create a manual order, click New and select Manual Order. Select the desired
supplier from the Supplier dropdown list. The PO number is automatically created for you. However, if
you wish to create a new PO, click the plus button. Finally, click Create Order to continue to the Edit
Order form.

On the Edit Order form, you must enter a line for each item you wish to order. Select Add to create a
line on the order. Use the down arrow in Item # to select an item from the list. (You can type an item
number to jump to it in the list.) If you do not know the item number for an item, use the search button
lEJ to open “Find Catalog ltem,” where you can type parts of the name, subject, or Unit (PACE)
number to find the catalog item.

| e b sl Ol ) e |
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After choosing the item, enter the quantity desired. After completing the added line, click Add to insert
a new line. Continue this process, editing each added line until you have completed the order.

To prepare an order for submission, take the following steps:

» Select a shipping method using the Ship Via dropdown list.

» Select the desired shipping address from the Shipping Address dropdown list.

+ If this order will be submitted via the Internet from School Management, make sure the Send
via Web check box is selected.

» Click Ready to Send to prepare the order for submission.

Submitting an Order

Once the order has been prepared for submission, the following actions are available for the order:

* Re-open Order — Allows you to re-open the order for editing

* Print Copy — Prints the Order Report for this order

+ Save to File — Saves this order to a file for manual off-site submission (see below)
+ Send Now — Submits this order to A.C.E. via the Internet

The status of submitted orders is updated periodically at the School Management web portal.
Submitted orders can be seen at studentmanage.com. Orders sent with Send Now will also show
these status updates in the Electronic Status column:

* Received — Order has been received by the Portal website. The Portal reviews each order and
if any discontinued items were included, they will be removed and replaced by the equivalent
current item when possible. These changes are noted in the Order Status.

+ Submitted — Order has been submitted to A.C.E. order processing.

* OnHold — Order has entered processing by A.C.E. but cannot proceed. Most often, it is
awaiting payment. A Pay for Order link will appear when an order has this status. Clicking the
link will open a payment page in your web browser showing the total cost for the order with a
Pay Now option to pay online via credit card. You can also contact A.C.E. Customer Service to
make a payment for the order.

* Processing — Order is being prepared for shipment.

* InvoicedComplete — Order processing is completed. It is either awaiting shipment or has been
shipped.


http://studentmanage.com
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Uploading a Manual Order File

Orders can also be saved as a file to be uploaded later at the Portal website. For an order that is
Ready to Send:

» From the Edit Order menu item, click Save to File.

» Save the file to an external hard drive, flash drive, or other portable device to transport it to a
computer with Internet access.

* Log on to the Portal at studentmanage.com.

* Click the Orders tab.

* Click Upload Manual Order File.

» Navigate to the order file to select it and click Upload. The order will appear in your Recent
Orders list.

» The order status is updated periodically in the School Management web portal. Though it will
not be visible as Electronic Status in the software, the status history can be seen by going to
studentmanage.com. (See Submitting an Order above for more on these statuses.)

Editing an Order

You can select any order and click Edit to open Edit Order. This will allow you to see more details
about the order.

Only orders with Open as the order status can be edited. (A “ReadyToSend” order can be “re-
opened,” but all others will be display only.) Orders submitted using Send Now will show more
detailed order status updates. (Example: Orders showing an electronic status of InvoicedComplete
may show a tracking number for a shipped order.)

Deleting an Order

To delete an order, select the desired order and then click Delete. You will be prompted for
confirmation before the delete occurs. IMPORTANT! This action does not contact the supplier to
cancel any orders. If the order has already been submitted to A.C.E. or another supplier, you
must contact them to complete the cancel/delete process.
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Receive Order

The Receive Order page allows you to receive an order into School Management inventory. Select
an order from the Receive Order dropdown list. Items from the order are displayed. To mark all items
from the order as Received, click Receive All Items on the menu bar. To only receive some of the
order items, modify the Qty Received column for each individual item.

Browse Inventory

The Browse Inventory page allows you to see current inventory items that have been ordered or
received as In Stock. Note that items already issued to students are not displayed, since they are in
the possession of the student rather than the school.

Adding Inventory

To manually add an item to inventory, click Add. This will open the Add Inventory Manually form.

[ 'add Inventory Manually j'

ltems ordered through School Management will automatically be added
to inventory when the order is submitted orthe PO is printed.

tten | deld

Item Number | |

Quantity 18

Assigned Student | QJ

oo ]

To add to your inventory using this form:

* Use the down arrow for Item to select an item from the list. (You can type an item number to
jump to it in the list.) If you do not know the item number for an item, use the search button
£, toopen “Find Catalog Item.” If the item you are adding to inventory is a new catalog item
from another supplier, click . to add the details of the new item to your school’s catalog.

» Enter the quantity being added to inventory.

» Select the student this item is being assigned to (optional).

+ Click Save. The form remains open, allowing you to enter more items to inventory if desired.

* When you are finished adding inventory, click Done to close the form.
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Issuing PACE Inventory

Though more common to issue from the PACE score boxes on Progress Control (see page 54),
PACE items with a student name in the Assigned Student column and the PACE on the current
year’s Progress Control can be issued by selecting the line and clicking Issue. With the PACE in the
possession of the student, it will no longer appear in Browse Inventory.

Assigning Inventory

To assign an inventory item to a student, select any item that does not have Assigned Student and
click Assign. You will then be given the option to select a student. Assignments can only be made to
a student with that PACE on the Progress Control of the current year.

Unassigning and Reassigning Inventory

To unassign an inventory item, select any inventory item that has been assigned to a student and
click Unassign.

To reassign an inventory item to a different student, select any assigned item and click Reassign to
both remove the student name and let you select another to put in its place. The Select Person form
will be displayed, allowing you to choose the student you wish to reassign the item to.

Changing Inventory Status

To manually change the status of an inventory item, select the inventory item and click Change
Status.

Suppliers

To add items to track using Inventory settings, another supplier must NOTE: A C.E. is the default
be added to the Suppliers page. The following actions are available to | supplier in School Management

manage suppliers: and cannot be deleted from the
system.

* New — Displays the Add New Supplier form to add an entry to the
page. Enter values as needed (only Name is required) and click Save.

» Edit — Select a line and click Edit to open Edit Supplier to change information for the supplier.
(A.C.E. opens only for display, as it cannot be edited.)

» Delete — Click the supplier you wish to delete and click Delete (unavailable for A.C.E.).
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Catalog

Select Catalog to view and manage catalog items in School Management. Text boxes below each
column heading allow you to type to find items. Entered text filters the catalog list to show only items
that match any part of the text entered. You can enter values in multiple text boxes to filter the result
as much as desired. The following actions are also available:

* Manual Update — This option is used to manually update the catalog using a downloaded
catalog file. To get the file, log in to the Portal at studentmanage.com and download a catalog
file from the Update tab. The Manual Update button allows you to select the downloaded file to
update the A.C.E. items in your catalog.

* New — Adds an item from a supplier other than A.C.E. to the catalog. The Catalog Item form
displays for you to enter information for the new item. Click Save to add the entered item.

» Edit — Allows you to edit a catalog item. Only catalog items that have been added can be
edited.

» Delete — Allows you to delete a catalog item. Only added items from a supplier other than
A.C.E. can be deleted.

In the Auto-Stock column, you can enter the quantity that you would like to keep in stock for that item.
When you create an automatic order, you can choose the option to Replenish PACE Inventory. This
option will add to the order any items needed to maintain the auto-stock quantity.

Subject Ordering Rules

The Subject Ordering Rules section allows you to manage ordering rules for the subjects found

in School Management. By default, all subjects are set to (auto) to order the latest edition printed
PACEs for the subject. To modify the Preferred Edition, select a new value from the dropdown list and
click Save.


http://studentmanage.com

@ronnec?

Chapter 11
Reports Section

The Reports menu displays a listing of all the reports in the system, sorted by category.
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To run a report, click the report name and the report to open the report Preview window. While
some reports display right away, most reports show a Parameter panel for you to select the desired
parameters for the report. Make your selection and click Submit to run the report.

When the report is displayed, various options are available from the menu bar, including Search,
Save, Print, and Zoom.

When you are finished with a report, close the Preview form by clicking the red X in the menu bar,
clicking the X in the upper right of the form, or choosing File > Exit.
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Chapter 12

iPad Application

The School Management iPad application can be used to assist with goal check, homework, and
attendance. In addition, the iPad can be used to take student photos. In order to use the iPad
application, a wireless network is required in your school or Learning Center. NOTE: The current iPad
application is supported on iPads running iOS 13 or higher.

Within the iPad application, floating panels can be expanded by swiping to the left and can be
collapsed by swiping to the right.

Logging In and Out

After starting the iPad application, you will be presented with the Login option. The Connection
dropdown list will contain the School Management server name. If the server name is not displayed
in this dropdown list, you will not be able to connect to School Management and should troubleshoot
your wireless network.

Enter your username and password, then tap Login. If the login is successful, you will see the
message “Connected successfully!”

To logout at any time, tap the Home menu and Logout.

Student Goals and Homework

To manage student goals and homework, tap the Students menu. A list of students is displayed.
Selecting any student name allows you to manage homework, goals, and notes for the student. This
screen defaults to the current date. Navigate to a different date by using the arrows on either side of
the displayed date.

Homework Slips

Existing homework slips for the displayed date are shown under the Homework Slips heading.
To view or edit an existing homework slip, tap the item. To add a new homework slip, tap Add
Homework Slip.
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When adding or editing a homework slip, the following fields are available:

» Subject — A dropdown menu for selecting a subject

* From Page — The beginning page for the homework assignment

» To Page — The ending page for the homework assignment

» Task — Include additional information if desired.

* Due — The due date for the homework assignment

« Status button — Choose Incomplete, Not Signed, or Signed as appropriate.

Additional details can be added in the note area below the Status buttons.

Select Save when you have entered the information desired.

Attendance

To manage attendance, select the Attendance menu. A list of students is displayed, along with their
attendance status for the selected date. To change the attendance for any student, select the student
name and select the desired status from the list presented. Changed items are automatically saved to
School Management.

Review Iltems

Review items are items that require special attention, such as overdue items or items that require a
supervisor’s approval. Tap the Review menu to see outstanding review items. Select any item to see
more detail or to modify the item.
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Details
The Details section allows you to view student notes and homework items in list form.

Notes

To view existing student notes, tap the Notes menu, then select the desired student. Notes for the
selected student are displayed. Tap a note to modify it, or select the + sign to add a new note.

Homework

To view existing student homework, tap the Homework menu, then select the desired student.
Homework items for the selected student are displayed. Tap a homework item to modify it, or click the
+ sign to add a new homework item.

Photos

To view existing student photos, select the Photos menu. Thumbnail photos for each student are
displayed beside the student’s name. Select the student name to view a larger version of the
student’s photo. To take a new photo for a student, use the following steps:

+ Select a student.

« Tap Take Photo to take a new image.

» Use a two-finger pinch gesture to scale the image as desired. Drag the image to move it as
desired.

* To retake the image, tap Retake.

» To accept and use the image, tap Use.
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Chapter 13

Release History

Version 2.0

Released Version: 2.0
Date: 9/2022

Transition SMS Server foundation from Microsoft® SQL Server 2012 Express to Microsoft® SQL
Server 2019 Express

Version 1.9

Released Version: 1.9.7573

Date: 9/2020

Updated iPad application (v. 1.22) to run iOS 13 or higher

Addressed formatting and reporting issues for Academic Records Reports

Added Quick Score Entry for PACE/Unit Scores to the Students section

Added Issued (1) and Ordered (O) dates for incomplete PACEs to Supervisor’s Progress Report

Version 1.8

Released Version: 1.8
Date: 11/15/2016

Made program modifications to support ordering through School Management after Distribution
Center software update

Maintenance updates released addressing bugs reported by users up through 7/2018

Version 1.7

Released Version: 1.7
Date: 9/29/2016



_/ﬁ 93
efﬂﬂnec )
HOLL M

AMAGEMENT

Added a check on Family Save to make sure a valid Mailing Address has been entered
Fixed Congratulation Slips fail in Spanish (Mexico) Region settings

Fixed Supervisor’s Progress Report not printing correct Supervisor

Added new layout for High School Transcript report

Allowed Permanent Record to be printed when standardized test scores are missing
Fixed foreign Key errors on Academic Projections

Fixed non-PACE items not displaying on transcript

Changed popup when running reports to only present if the Academic Year is being changed to a
new one in which no students have been enrolled yet

Version 1.6

Released Version: 1.6

Date: 3/2016

Removed compatibility with Windows XP
Added compatibility with Windows 8
Added compatibility with Windows 10

Various bug fixes

Version 1.5

Released Version: 1.5

Date: 7/2015

Added ordering features to select individual students
Added ordering features to replenish inventory

Added reenroll feature when switching to new school year
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Added Batch Transactions to Billing

Added a Merits Report

Added an Order Report by Student

Added backup location selection

Added the Overall High School Average

Added feature to remove or replace inactive items on orders

Various bug fixes

Version 1.4

Released Version: 1.4.5538

Date: 5/29/2015

Fixed display issue on Academic Projection Report and Goal Check Report
Fixed permissions to allow photos to be taken with iPad and browsing finances
Fixed GPA calculation to use the student’s final academic year

Fixed bug if Administrators Role is renamed

Fixed error with O credit subjects

Fixed errors billing for PACEs

Fixed error changing the quarter dates for the current school year

Version 1.3

Released Version: 1.3
Date: 1/20/2015

Added a default permission for admin and supervisors named Override Inventory to override
inventory requirements when assigning PACEs

Allowed a user to issue an inventory item, override the requirement to have that PACE in
inventory, and not subtract the PACE from inventory when issued

Bug fixes on Inventory and Student Progress Report
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Version 1.2

Released Version: 1.2.5373
Date: 9/17/2014

Bug fixes to the following items:

» California grading scale

* Printing Congratulations slips

* PACE order labels

+ Billing statement

» Subject ordering prerequisites

Version 1.1

Released Version: 1.1.5330
Date: 8/5/2014
Academic Projection Toward Graduation added as a new report

A quarterly average added for each subject on the Student Progress Report in addition to the
yearly average

Various Bug Fixes

Released Version: 1.1.5339
Date: 8/14/2014
Bug fixes on Goal Check

Version 1.0

Released Version: 1.0.5305
Date: 7/11/2014

First release of aceconnect School Management



